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                                                                                Abstrak  

 

Jagung adalah salah satu produk pertanian yang banyak dihasilkan di Indonesia. Pada tahun 2021, provinsi Jawa 

Tengah menghasilkan 3,18 juta ton jagung. Kandungan hemiselulosa dan selulosa pada tongkol jagung berpotensi 

untuk diolah menjadi glukosa yang kemudian difermentasi sehingga menghasilkan bioetanol. Pemanfaatan 

bioetanol perlu ditingkatkan untuk mengganti bahan bakar fosil yang cadangan sumber energinya semakin 

menipis. Berdasarkan masalah tersebut, penelitian ini bertujuan untuk melakukan digitalisasi pemetaan potensi 

jagung menjadi bioetanol di Jawa Tengah dengan menggunakan aplikasi Quantum GIS (QGIS). Penelitian ini 

diawali dengan melakukan studi literatur, pengumpulan data sekunder, pengolahan data hingga visualisasi dan 

layouting peta pada aplikasi QGIS, analisis data dan hasil pemetaan serta kesimpulan. Berdasarkan analisis data 

dan hasil pemetaan, didapatkan bahwa terdapat 6 kabupaten dan 6 kota dengan kapasitas 0 – 4.844 kl (kilo liter) 

masuk dalam klasifikasi wilayah tidak berpotensi bioetanol, 11 kabupaten masuk dalam klasifikasi wilayah yang 

cukup berpotensi menghasilkan bioetanol dengan kapasitas 4.844 – 20.096 kl, dan 12 kabupaten dengan kapasitas 

20.096 – 111.967 kl termasuk wilayah yang sangat berpotensi menghasilkan bioetanol. Dengan demikian, 

digitalisasi ini dapat menjadi acuan bagi pemerintah ataupun masyarakat Jawa Tengah dalam mengoptimalkan 

potensi tongkol jagung di masing-masing wilayah. 

 

Kata kunci : Bioetanol, QGIS, Tongkol Jagung 

 

 

1. Pendahuluan  

 

Indonesia merupakan negara yang kaya akan 

sumber daya alam yang sangat melimpah, baik 

sumber daya alam  yang dapat diperbaharui maupun 

sumber daya alam yang tidak dapat diperbaharui. 

Minyak bumi dan batu bara merupakan contoh bahan 

bakar yang tidak dapat diperbaharui dan 

ketersediaannya di alam semakin menipis. Namun, 

hingga saat ini kebutuhan energi bahan bakar fosil 

terus mengalami peningkatan seiring dengan 

meningkatnya pertumbuhan industri dan ekonomi. 

Badan Pengatur Hilir Minyak dan Gas Bumi (BPH 

Migas) memproyeksikan jika konsumsi Bahan Bakar 

Minyak (BBM) nasional pada tahun 2021 melesat 

hingga 15 % dari konsumsi BBM pada tahun 2020. 

Dengan kenaikan sebesar 15 %, maka konsumsi 

BBM nasional pada tahun 2021 ini akan menyentuh 

75 juta  kilo liter (kl) atau setara dengan 1,23 juta 

barel per hari (bph) dibandingkan tahun 2020 yang 

hanya mencapai 65 juta kl atau setara dengan 1,06 

juta bph (cnbcindonesia.com, 2021). Peningkatan  

konsumsi BBM ini akan mengakibatkan krisis energi 

jika suatu negara  belum dapat mengurangi 

ketergantungan  terhadap bahan bakar fosil, 

sedangkan cadangan sumber energi tersebut semakin 

terbatas. Selain itu, penggunaan bahan bakar fosil 

dapat mengakibatkan pencemaran udara akibat 

pembakaran yang menghasilkan gas CO2. Oleh 

karena itu, sudah saatnya penggunaan sumber energi 

terbarukan  berupa bahan bakar nabati atau bioenergi 

ditingkatkan untuk mengganti bahan bakar fosil yang 

semakin menipis seperti dalam Inpres No 1/2006 dan 

Perpres No 5/2006 tentang kebijaksanaan energi 

nasional (Meutia et al, 2016).. Adapun potensi bahan 

bakar nabati  yang dapat dikembangkan di Indonesia 

yaitu bioetanol. 

Bioetanol adalah cairan biokimia dari proses 

fermentasi gula dari sumber glukosa, selulosa, dan 

pati atau karbohidrat menggunakan bantuan 

mikroorganisme. Keuntungan atau kelebihan dari 

penggunaan bioetanol yaitu dapat diproduksi secara 

terus menerus, ramah lingkungan, serta dapat 

digunakan sebagai bahan baku industri kimia, 

kosmetik, farmasi, dan sebagai bahan bakar 

(Masfufatun, 2012 dalam Khaira et al, 2015). Salah 

satu bahan baku yang dapat dijadikan bioetanol 

adalah jagung. Jagung merupakan salah satu produk 

pertanian  yang banyak dihasilkan di Indonesia. Pada 

tahun 2021, produksi jagung nasional diperkirakan 

meningkat menjadi 24,04 juta ton dari 23,95 juta ton 

pada tahun 2020 atau naik sebesar 0,39 % 
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(pertanian.go.id, 2020). Berdasarkan Pusat Data dan 

Sistem Informasi Kementerian Pertanian, provinsi 

Jawa Tengah dengan luas panen 614,3 ribu ha dapat 

menghasilkan 3,18 juta ton jagung. Dengan produksi 

jagung tersebut, provinsi Jawa Tengah menempati 

urutan kedua sebagai 10 provinsi penghasil jagung 

terbesar di Indonesia dari beberapa provinsi lain 

seperti Jawa Timur, Lampung, Sumatera Utara, 

Sulawesi Selatan, Nusa Tenggara Barat, Jawa Barat, 

Sulawesi Utara, Gorontalo, dan Sumatera Selatan 

(pertanian.go.id, 2021). Menurut Irawadi (1990 

dalam Kalsum 2018), buah jagung terdiri dari 30 % 

limbah yang berupa tongkol jagung. Jika 

dikonversikan dengan jumlah produksi jagung pada 

tahun 2021, maka provinsi Jawa Tengah berpotensi 

menghasilkan tongkol jagung sebanyak 0,954 juta 

ton. Jumlah limbah tersebut dapat dikatakan sangat 

banyak dan akan menjadi potensial jika dapat 

dimanfaatkan secara tepat terutama sebagai bahan 

baku pembuatan bioetanol. 

Pemanfaatan tongkol jagung saat ini masih 

sangat terbatas. Kebanyakan limbah tongkol jagung 

hanya digunakan untuk bahan tambahan makanan 

ternak, atau hanya digunakan sebagai pengganti kayu 

bakar dan dapat juga dibuat briket (Susanto et al, 

2013). Di Jawa Tengah sendiri sebagian besar 

wilayah masih belum memanfaatkan  tongkol jagung 

dengan baik. Bahkan, hanya dibuang dan dibakar 

sehingga dapat menimbulkan masalah polusi, efek 

rumah kaca, dan pemanasan global. Dengan melihat 

limbah yang tidak termanfaatkan tersebut, maka 

peluang pemanfaatan tongkol jagung untuk menjadi 

bahan bakar alternatif atau bioetanol semakin besar, 

sehingga tongkol jagung dapat dimanfaatkan secara 

optimal dan memiliki nilai ekonomi yang lebih tinggi. 

Berdasarkan pemaparan masalah tersebut, digitalisasi 

pemetaan menggunakan aplikasi QGIS (Quantum 

GIS)  ini bertujuan untuk mengetahui klasifikasi 

wilayah di provinsi Jawa Tengah berdasarkan potensi 

jagung yang dapat dimanfaatkan menjadi bioetanol, 

mengetahui wilayah yang berpotensi besar 

menghasilkan jagung sebagai bahan baku bioetanol  

dan juga menganalisis faktor-faktor yang dapat 

mempengaruhi kuantitas potensi jagung yang 

dihasilkan. Dengan adanya pemetaan ini, diharapkan 

dapat menjadi acuan bagi masyarakat ataupun 

pemerintah dalam mengoptimalkan tongkol jagung 

menjadi bioetanol sesuai dengan potensi di masing-

masing wilayah. 

 

2. Tinjauan Pustaka 

 

2.1 Digitalisasi Pemetaan 

 

Teknologi Sistem Informasi Geografis (SIG) 

adalah teknologi yang memiliki kemampuan untuk 

secara geografis mengumpulkan, mengelola, 

memanipulasi dan memvisualisasikan data spasial 

yang terkait dengan posisi permukaan bumi pada peta 

sesuai dengan posisi sebenarnya dari permukaan 

bumi dengan titik koordinat informasi dan dapat 

menghasilkan informasi geografi berupa peta digital 

(Ardiansyah dan Kardono, 2017). Dari pendapat ahli, 

dapat disimpulkan bahwa pemetaan dengan 

digitalisasi sangat penting karena dapat melihat atau 

menerjemahkan data ke bentuk visualisasi pemetaan 

(Fahri, 2020). Salah satu aplikasi sistem informasi 

geografis yang bisa digunakan adalah Quantum GIS 

(QGIS). Quantum GIS adalah aplikasi SIG gratis 

yang mencakup pemetaan, analisis spasial dan 

beberapa fitur desktop GIS lainnya. Aplikasi ini sama 

dengan paket aplikasi GIS komersial, namun aplikasi 

ini didistribusikan secara gratis di bawah lisensi 

GNU. Quantum GIS mendukung format data vektor, 

raster dan database. QGIS ini memiliki keuntungan 

di antaranya aplikasi ini bersifat open source 

sehingga siapa saja dapat menggunakannya serta 

QGIS memiliki tampilan simple dan user friendly 

(Fitri dan Ferdiansyah, 2017). 

 

2.2 Tongkol Jagung  

 

Tongkol jagung merupakan salah satu limbah 

lignoselulosik yang banyak tersedia di Indonesia. 

Limbah lignoselulosik adalah limbah pertanian yang 

mengandung selulosa, hemiselulosa, dan lignin. 

Masing-masing merupakan senyawa yang potensial 

dapat dikonversi menjadi senyawa lain secara biologi. 

Selulosa merupakan sumber karbon yang dapat 

digunakan mikroorganisme sebagai substrat  dalam 

proses fermentasi untuk menghasilkan produk yang 

mempunyai nilai ekonomi tinggi (Shofiyanto, 2008). 

Menurut Irawadi (1990 dalam Kalsum 2017), buah 

jagung terdiri dari 30 % limbah yang berupa tongkol 

jagung. 

 
Gambar 1. Tongkol Jagung 

(Sumber : kompasiana.com, 2018) 

 

Karakterisitik kimia dan fisika  dari tongkol 

jagung sangat cocok untuk pembuatan energi 

alternatif (bioetanol). Kadar senyawa kompleks 

lignin dalam tongkol jagung adalah 6,7-13,9 %, untuk 

hemiselulosa 39,8 %, dan selulosa 32,3-45,6 %. 

Selulosa hampir tidak ditemui dalam keadaan murni 

di alam, melainkan selalu berikatan dengan bahan 

lain yaitu lignin dan hemiselulosa (Fachry et al, 

2013). 

Menurut Shofiyanto (2008), limbah pertanian 

(termasuk tongkol jagung), mengandung selulosa 
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(40-60 %), hemiselulosa (20-30 %), dan lignin (15-30 

%). Komposisi kimia tersebut membuat tongkol 

jagung dapat dimanfaatkan sebagai sumber energi, 

bahan pakan ternak dan sebagai sumber karbon bagi 

pertumbuhan mikroorganisme. 

 

Tabel 1. Komposisi Tongkol Jagung 

Kandungan Persentase (%) 

Selulosa 41 

Hemiselulosa 36 

Lignin 16 

Air dan lain-lain 7 

Sumber : Shofiyanto, 2008 

 

2.3  Bioetanol 

 

Bioetanol adalah senyawa alkohol dengan 

gugus hidroksil (OH) yang berasal dari sumber 

hayati, 2 atom karbon (C) dengan rumus kimia  

C2H5OH yang dibuat dengan cara fermentasi gula 

menggunakan khamir atau yang sering disebut 

fermentasi alkohol. Senyawa tersebut juga dapat 

diperoleh dengan cara sintetik, yang sering disebut 

dengan etanol. Etanol dengan bahan baku gula 

disebut bioetanol karena gula berasal dari sumber-

sumber hayati dan melalui proses fermentasi. Etanol 

merupakan zat cair, tidak berwarna, mudah terbakar, 

menguap, dapat bercampur dengan air dan berbau 

yang spesifik. Bioetanol bersumber bahan hayati, 

pada awalnya dibuat dari gula dan pati yang diperoleh 

dari tebu, singkong, dan lainnya. Etanol berbahan 

gula ini selain diberi nama fermentation ethanol juga 

disebut bioetanol generasi pertama. Etanol generasi 

kedua, yaitu bioetanol dari bahan selulosa, yang 

sering disebut juga dengan cellulosic ethanol 

(Megawati, 2015). 

Selulosa merupakan jenis polisakarida yang 

melimpah pada setiap struktur tanaman. 

Hemiselulosa merupakan rantai cabang dari 

polisakarida yang mengandung pentosa. 

Hemiselulosa memiliki ikatan kovalen dengan lignin 

dan ikatan hidrogen dengan selulosa. Hemiselulosa 

bertindak sebegai perekat antara selulosa dan lignin. 

Lignin merupakan senyawa yang berfungsi sebagai 

pengikat komponen penyusun tanaman (hemiselulosa 

dan selulosa) (Sihotang et al, 2018).  

 

3. Metodologi 

 

3.1 Sumber Data 

Dalam melakukan pemetaan ini, data yang 

digunakan yaitu data sekunder. Adapun data sekunder 

yang digunakan adalah data potensi biofuel  jagung 

yang diperoleh dari situs web resmi Pemerintah 

Provinsi Jawa Tengah Dinas Energi dan Sumber 

Daya Mineral tahun 2016. Selain itu, untuk 

kebutuhan analisis hasil pemetaan, maka digunakan 

pula data luas wilayah yang diperoleh dari situs web 

Badan Pusat Statistik Jawa Tengah tahun 2020. 

3.2 Kerangka Berpikir 

 

Mulai

Studi Literatur

Pengumpulan Data 

Sekunder

Input Data 

Visualisasi dan Layouting Peta 

Pada Aplikasi Quantum GIS

Analisis Data dan Hasil 

Pemetaan

Kesimpulan

Selesai

 
Gambar 2. Flowchart Kerangka Berpikir 

 

Berikut uraian diagram alur dalam melakukan 

pemetaan data : 

1. Studi literatur tentang pemanfaatan tongkol 

jagung menjadi bioetanol. 

2. Mencari data potensi biofuel jagung di provinsi 

Jawa Tengah : https://esdm.jatengprov.go.id/.  

3. Siapkan pula data luas wilayah yang dibutuhkan 

dalam melakukan analisis hasil pemetaan: 

https://jateng.bps.go.id.  

4. Memasukkan data potensi jagung (Ton) dan 

potensi jagung yang Diubah Ke Bioetanol (kl) 

pada software Quantum GIS. 

5. Melakukan visualisasi dan layouting peta 

berdasarkan data yang telah diinput. 

6. Analisis data potensi jagung yang dapat diubah 

menjadi bioetanol berdasarkan pada hasil 

digitalisasi pemetaan. 

7. Penarikan kesimpulan dari hasil analisis data dan 

pemetaan pada QGIS yang berupa uraian untuk 

menjawab tujuan penelitian. 

 

3.3 Teknik Penyajian Data 

Data potensi jagung dan luas wilayah provinsi 

Jawa Tengah yang digunakan disajikan dalam bentuk 

tabel. Selain itu, prosedur visualisasi dan layouting 

peta disajikan dalam bentuk gambar. sedangkan, 

analisis data dan hasil pemetaan disajikan dalam 

bentuk narasi. 

 

 

 

https://esdm.jatengprov.go.id/
https://jateng.bps.go.id/
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4. Hasil dan Pembahasan 

 

4.1 Hasil 

 

Berikut adalah langkah-langkah  membuat 

visualisasi dan layouting peta potensi jagung menjadi 

bioetanol di provinsi Jawa Tengah. 

1. Siapkan data potensi jagung di provinsi Jawa 

Tengah. Berikut data yang diperoleh dari situs : 

https://esdm.jatengprov.go.id/ . 

 

 
Gambar 3. Potensi Biofuel Jawa Tengah 

 

2. Buka file “INDONESIA_KAB”. 

Gambar 4. Tampilan “INDONESIA_KAB” 

 

3. Klik kanan pada layer “INDONESIA_KAB”. 

Lalu pilih filter dan lakukan penyaringan data 

dengan menampilkan peta Jawa Tengah. 

Gambar 5. Tampilan Filter Data 

 

4. Klik kanan pada layer INDONESIA_KAB → 

Pilih Export → Save Feature As → Tentukan 

lokasi penyimpanan pada bagian file name dan 

beri nama “IND_JATENG.gpkg” → Simpan → 

klik OK. Setelah terbentuk layer IND_JATENG, 

selanjutnya klik kanan pada layer 

INDONESIA_KAB dan pilih remove layer. 

 

 
Gambar 6. Tampilan Seleksi Area Peta 

 

5. Klik menu Vector → Geoprocessing Tools → 

Dissolve → Pada bagian Dissolve field (optional) 

pilih “Kabupaten” → Klik OK. Pada bagian 

Dissolved, klik titik 3 di sisi kanan → Save to 

File → Beri nama “IND_PROVINSI JATENG” 

→ Simpan → Klik Run. Setelah berhasil 

melakukan Dissolve, lalu hapus layer lama 

“IND_JATENG” dengan cara klik kanan → 

Remove layer. 

     
Gambar 7. Tampilan Dissolve 

6. Klik icon Open Attribute Table → Dock 

Attribute Table (agar lebih rapi) → Toggle 

Editing Mode → Delete Field → Hapus Field 

yang tidak diperlukan dan sisakan field fid, ID, 

dan Kabupaten. Selanjutnya, tambahkan field 

sesuai data potensi bioetanol dari jagung yang 

sudah diperoleh sebelumnya dengan cara klik 

New Field → Isi nama field dan tentukan tipe 

datanya → Lengkapi isi data field nya → Jika 

sudah terisi data nya lalu close. 

https://esdm.jatengprov.go.id/
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      Gambar 8. Tampilan Open Attribute Table 

 

7. Klik kanan pada layer IND_PROVINSI 

JATENG → Pilih Properties → Symbology → 

Categorized → Isi value dengan opsi 

“Kabupaten” → Pilih Color Ramp sesuai selera, 

misalnya pada peta ini menggunakan “Plasma” 

→ Klik Classify → Apply → OK. 

            

 
 

Gambar 9. Tampilan Symbology Categorized 

 

8. Untuk memunculkan label peta, klik icon Layer 

pada menu toolbar → Labeling →Ubah No 

Labels menjadi Single Labels → Isi value dengan 

opsi “Kabupaten” → Aktifkan Draw Text Buffer 

→ Klik Apply. 

            

 

Gambar 10. Tampilan Labeling Peta 

 

9. Untuk membedakan daerah yang berpotensi dan 

tidak, maka klik kanan pada layer 

IND_PROVINSI JATENG → Properties → 

Symbology → Graduated → Isi value dengan 

opsi “Potensi Jagung Diubah Ke Bioetanol (KL)” 

→ Pilih warna dibagian Color Ramp sesuai 

selera → Pada bagian classes isi dengan angka 3 

(untuk 3 warna) → Klik Classify → Atur warna 

dibagian symbol menjadi biru (tidak berpotensi 

bioetanol), merah (cukup berpotensi bioetanol), 

dan hijau (sangat berpotensi bioetanol) → Atur 

pula pada bagian value dan legend →Klik apply 

→ Klik OK. 

 

Gambar 11. Tampilan Symbology Graduated 

 

10. Tambahkan titik centroid dengan cara klik menu 

vector → Geometry Tools → Centroids → Klik  

tombol titik 3 di samping kanan field centroids 

→ Save to File → Tentukan lokasi penyimpanan 

dan beri nama “IND_PROVINSI JATENG 

CENTROID” → Save → Run → Close. 

 

Gambar 12. Tampilan Geometry Tools Centroid 

 

11. Selanjutnya, buat tanda kapasitas potensi 

bioetanol dari jagung di masing-masing wilayah 

dengan mengatur variasi ukuran centroid. Klik 

kanan layer IND_PROVINSI JATENG 

CENTROID → Properties → Symbology → 

Graduated → Pada field value pilih opsi “Potensi 

Jagung Diubah Ke Bioetanol (KL)” → Pilih 

warna sesuai selera pada bagian symbol → Pilih 

opsi size pada bagian method → Atur classes 

dengan angka 3 → Klik classify → Apply → OK. 
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Gambar 13. Tampilang Setting Ukuran Centroid 

12. Hasilnya adalah sebagai berikut. 

Gambar 14. Tampilan Visualisasi Peta 

 

13. Setelah tahap visualisasi peta selesai, kemudian 

dilanjutkan dengan layouting peta. Klik menu 

project → Pilih New Print Layout → Beri judul 

layout dengan nama “Pemetaan Potensi Jagung 

Menjadi Bioetanol di Jateng”. 

 
Gambar 15. Tampilan New Print Layout 

 

14. Pada lembar layout klik Add Shape → Pilih 

Rectangle → Buatlah kotak pada layout. 

Kemudian, klik kanan pada layout → Item 

properties → Pilih warna background sesuai 

selera. 

     
Gambar 16. Tampilan Background Layout Peta 

15. Klik Add Map → Tambahkan peta pada halaman 

layout → Klik Move Item Content untuk 

menyesuaikan posisi peta pada layout. 

Gambar 17. Tampilan Add Map 

 

16. Klik kanan item Map → Item properties → 

Aktifkan fitur Grid pada peta dengan klik icon 

“+” → Klik modify grid → Buat rentang grid 

peta dalam hal ini X = 0,800; dan Y = 0,800 → 

Ubah frame style menjadi model zebra → 

Aktifkan draw coordinates → Ubah bagian left 

dan right dari horizontal menjadi vertical 

ascending. 

Gambar 18. Tampilan Modify Grid 

 

17. Klik icon Add North Arrow, buatlah arah mata 

angin ke atas pada kotak di sebelah peta. 

Kemudian klik icon Add label → Atur 

penempatannya → Klik kanan pada item label → 

Pilih item properties → Tulis N (North) pada 

bagian main properties → Atur jenis, ukuran, 

dan justifikasi font. Ulangi langkah tersebut 

untuk memberikan keterangan arah W (West), S 

(South), dan E (East). 

  
Gambar 19. Tampilan Add North Arrow 

18. Klik icon Add Legend → Tetukan lokasi untuk 

menambahkan legenda. Setelah legenda 

ditampilkan, klik kanan item Legend → Pilih 

item properties → Tambahkan judul pada bagian 
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title, yaitu “Keterangan Peta :”→ Atur ukuran, 

tipe, dan justifikasi font. 

Gambar 20. Tampilan Add Legend 

 

19. Berikan tulisan skala dengan klik Add label → 

Tentukan posisi penempatannya → Klik kanan 

item label → Ketik “SKALA” pada bagian main 

properties → Atur ukuran, jenis, dan justifikasi 

font. Tambahkan skala dengan klik icon Add 

Scalebar → Tentukan lokasi penempatan baris 

skala → Klik kanan item scalebar → Pilih item 

properties → Pada bagian style ubah menjadi 

bentuk numeric → Atur ukuran, jenis, dan 

justifikasi font. 

      
Gambar 21. Tampilan Add Scalebar 

20. Pilih icon add label untuk menambahkan judul 

pada bagian identitas → Klik kanan item label → 

Pilih item properties → Ketik judul identitas peta 

yaitu “Potensi Bioetanol Jagung di Jawa 

Tengah”. Kemudian pilih add picture 

(menambahkan logo) → Tentukan 

penempatannya → Klik kanan item picture → 

Pilih item properties → Aktifkan raster image → 

Klik tanda titik 3 yang terletak di bagian bawah 

tulisan raster image, lalu pilih file picture → 

Atur penempatan picture di bawah judul identitas 

peta → Pada bagian placement pilih opsi middle. 

Di bawah logo tambahkan nama identitas 

kelompok dengan cara klik add label → Atur 

penempatannya → Klik kanan item label → Pilih 

item properties → Ketik nama identitas 

kelompok pada bagian main properties → Atur 

ukuran, jenis dan justifikasi font pada bagian 

appearance. 

Gambar 22. Tampilan Penambahan Identitas 

Kelompok 

21. Langkah terakhir adalah klik menu layout, pilih 

Export to Pdf, tentukan lokasi penyimpanan dan 

nama file, kemudian simpan. Lakukan langkah 

yang sama untuk ekspor kedalam bentuk gambar 

(.png).  

 
Gambar 23. Tampilan Akhir Penyimpanan File 

 

4.2 Pembahasan 

 

Tabel 2. Luas Wilayah Provinsi Jawa Tengah 

Kabupaten/Kota Luas Wilayah (km2) 

Kabupaten Cilacap 2. 124,47 

Kabupaten Banyumas 1. 335,30 

Kabupaten Purbalingga 677,55 

Kabupaten 

Banjarnegara 
1. 023,73 

Kabupaten Kebumen 1. 211,74 

Kabupaten Purworejo 1. 091,49 

Kabupaten Wonosobo 981,41 

Kabupaten Magelang 1. 102,93 

Kabupaten Boyolali 1. 008,45 

Kabupaten Klaten 658,22 

Kabupaten Sukoharjo 489,12 

Kabupaten Wonogiri 1. 793,67 

Kabupaten 

Karanganayar 
775,44 

Kabupaten Sragen 941,54 

Kabupaten Grobogan 2. 013,86 

Kabupaten Blora 1. 804,59 

Kabupaten Rembang 887,13 

Kabupaten Pati 1. 489,19 

Kabupaten Kudus 425,15 

Kabupaten Jepara 1. 059,25 

Kabupaten Demak 900,12 

Kabupaten Semarang 950,21 

Kabupaten 

Temanggung 
837,71 
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Kabupaten/Kota Luas Wilayah (km2) 

Kabupaten Kendal 1. 118,13 

Kabupaten Batang 788,65 

Kabupaten Pekalongan 837,00 

Kabupaten Pemalang 1 .118,03 

Kabupaten Tegal 876,10 

Kabupaten Brebes 1. 902,37 

Kota Magelang 16,06 

Kota Surakarta 46,01 

Kota Salatiga 57,36 

Kota Semarang 373,78 

Kota Pekalongan 45,25 

Kota Tegal 39,68 

Sumber : BPS Provinsi Jawa Tengah, 2020 

 

Dilihat dari data sekunder pada gambar 3. 

mengenai potensi biofuel jagung, maka dapat 

diketahui bahwa hampir seluruh kabupaten/kota di 

wilayah Jawa Tengah berpotensi untuk mengolah 

limbah jagung (tongkol jagung) menjadi bioetanol. 

Data tersebut juga menunjukkan bahwa dari 35 

kabupaten/kota yang terdapat di wilayah Jawa 

Tengah hanya ada 4 wilayah yang tidak berpotensi 

menghasilkan bioetanol dari jagung dengan kapasitas 

0 kl. Wilayah tersebut di antaranya yaitu Kota 

Magelang, Kota Surakarta, Kota Pekalongan, dan 

Kota Tegal. 

Hasil pengamatan antara data sekunder yang 

belum dipetakan dengan data sekunder yang sudah 

dilakukan digitalisasi pemetaan menggunakan QGIS 

tentunya akan berbeda. Hal ini disebabkan karena 

data yang belum dilakukan pemetaan bersifat umum, 

artinya tidak ada klasifikasi angka yang dijadikan 

sebagai parameter kapasitas potensi bioetanol di 

setiap wilayah.  Sedangkan apabila mengamati data 

hasil pemetaan dengan menggunakan QGIS, maka 

akan diketahui secara jelas klasifikasi wilayah yang 

dibagi menjadi tiga kelas, yaitu wilayah yang tidak 

berpotensi, cukup berpotensi, dan sangat berpotensi 

bioetanol seperti yang dilihat dari visualisasi peta di 

bawah ini. 

 

 
Gambar 24. Visualisasi Pemetaan Potensi Tongkol 

Jagung Menjadi Bioetanol di Jawa Tengah 

 

Klasifikasi wilayah yang tidak berpotensi 

bioetanol  terdiri dari 6 kabupaten dan 6 kota dengan 

kapasitas 0 – 4.844 kl, di antaranya yaitu Kab. 

Cilacap, Kab. Banyumas, Kab. Purworejo, Kab. 

Sukoharjo, Kab. Kudus, Kab. Pekalongan, Kota 

Salatiga, Kota Semarang, Kota Magelang, Kota 

Surakarta, Kota Pekalongan, dan Kota Tegal. Adapun 

untuk klasifikasi wilayah yang cukup berpotensi 

menghasilkan bioetanol dengan kapasitas 4.844 – 

20.096 kl yaitu terdapat 11 kabupaten, di antaranya 

Kab. Purbalingga, Kab. Banjarnegara, Kab. 

Kebumen, Kab. Magelang, Kab. Klaten, Kab. 

Karanganyar, Kab. Sragen, Kab. Jepara, Kab. 

Semarang, Kab. Batang, dan Kab. Pemalang. 

Sedangkan untuk klasifikasi wilayah yang sangat 

berpotensi menghasilkan bioetanol dengan kapasitas 

20.096 – 111.967 kl tersebar di 12 kabupaten, di 

antaranya yaitu Kab. Wonosobo, Kab. Boyolali, Kab. 

Wonogiri, Kab. Grobogan, Kab. Blora, Kab. 

Rembang, Kab. Pati, Kab. Demak, Kab. 

Temanggung, Kab. Kendal, Kab. Tegal, dan Kab. 

Brebes. 

Berdasarkan klasifikasi wilayah hasil pemetaan, 

kabupaten Grobogan memiliki potensi yang sangat 

besar untuk menghasilkan bioetanol dari limbah 

jagung, dimana potensi jagung 559.835 Ton dapat 

menghasilkan bioetanol sebanyak 111.967 kl. Jika 

mengacu pada tinjauan pustaka, dimana disebutkan 

bahwa 30 % dari berat jagung adalah limbah jagung, 

maka kapasitas potensi bioetanol kabupaten 

Grobogan yang tertera pada data dapat dikatakan 

kurang sesuai dengan teori. Seharusnya, 30 % dari 

potensi jagung (Ton) di kabupaten Grobogan dapat 

menghasilkan 166.750,5 kl bioetanol. 

Jika dibandingkan antara wilayah yang sangat 

berpotensi dan tidak berpotensi menghasilkan 

bioetanol, sebagai contoh yaitu kabupaten Grobogan 

dan kota Magelang, Keduanya merupakan wilayah 

yang secara morfologi merupakan daerah dataran 

tinggi dengan relief pegunungan dan perbukitan serta 

dataran rendah di bagian tengah yang seharusnya 

sama-sama memiliki potensi unggul di bidang 

pertanian.  Kabupaten Grobogan sendiri memiliki 

relief pegunungan yaitu terletak di antara dua 

pegunungan Kendeng yang membujur dari arah barat 

ke timur, sehingga  kabupaten Grobogan merupakan 

kabupaten yang tiang penyangga perekonomiannya 

berada pada sektor pertanian (BAPPEDA Kabupaten 

Grobogan, 2012).  Sementara itu, secara topografis 

kota Magelang merupakan dataran tinggi yang berada 

380 m di atas permukaan laut dengan kemiringan 

berkisar 5° sampai 45° (magelangkota.go.id, 

2017). Berdasarkan hasil pengamatan, salah satu 

faktor yang membedakan kuantitas potensi jagung 

antara kabupaten Grobogan (wilayah yang sangat 

berpotensi bioetanol) dengan kota Magelang 

(wilayah yang tidak berpotensi bioetanol) adalah luas 

wilayahnya. Pada  tabel 2 dapat diketahui jika 

kabupaten Grobogan merupakan urutan kedua 

wilayah terluas di Jawa Tengah setelah kabupaten 

Cilacap, yaitu dengan luas wilayah 2.013,86 km2, 

sehingga kemungkinan besar lahan pertanian yang 
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tersedia di kabupaten Grobogan juga luas. Sementara 

itu, kota Magelang menjadi kabupaten dengan luas 

wilayah tersempit di Jawa Tengah yaitu hanya 16,06 

km2, sehingga lahan pertanian yang tersedia juga 

terbatas. 

 

5. Kesimpulan dan Saran 

Berdasarkan data yang diperloeh dan hasil 

digitalisasi pemetaan, maka dapat disimpulkan bahwa 

: 

1. Pemetaan potensi jagung menjadi bioetanol 

menggunakan QGIS menyajikan 3 klasifikasi 

wilayah, yaitu wilayah yang tidak berpotensi 

bioetanol dengan kapasitas 0 – 4.844 (kl), 

wilayah yang cukup berpotensi bioetanol dengan 

kapasitas 4.844 – 20.096 (kl), dan wilayah yang 

sangat berpotensi bioetanol dengan kapasitas 

20.096 – 111.967 (kl). 

2. Kabupaten Grobogan memiliki potensi yang 

sangat besar untuk menghasilkan bioetanol dari 

limbah jagung, dimana potensi jagung 559.835 

Ton dapat menghasilkan bioetanol sebanyak 

111.967 kl. 

3. Faktor-faktor yang dapat berpengaruh terhadap 

kuantitas potensi jagung yang dihasilkan, yaitu 

keadaan geografis dan luas wilayah. 

Digitalisasi pemetaan potensi jagung menjadi 

bioetanol di provinsi Jawa Tengah ini akan menjadi 

sangat bermanfaat apabila tidak hanya dijadikan 

sebagai referensi saja, melainkan pemerintah dapat 

memberikan dukungan dengan cara membuat 

kebijakan terkait pemanfaatan tongkol jagung sesuai 

dengan kuantitas potensi jagung yang dihasilkan oleh 

tiap-tiap wilayah berdasarkan hasil pemetaan. Selain 

itu, masyarakat juga diharapkan memiliki kemauan 

untuk mengoptimalkan pemanfaatan tongkol jagung 

menjadi bioetanol yang memiliki nilai ekonomi lebih 

tinggi. 
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